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Sharpening has long been one of the most essential but least-understood aspects of digital imaging. 
PhotoKit SHARPENER 2.0™ (PKS2) provides, not just a set of sharpening tools, but a complete sharpening 
workflow from capture to output that is designed to produce optimum sharpness on any image, from any 
source, reproduced on any output device, while still leaving enough control to address both the differing 
requirements of individual images and the differing tastes of individual users. 

If you simply want to start using PKS2 right away, you can skip ahead to the “New Features” on page 4, 
but the following discussion may be useful to help you understand why we created the sharpening workflow 
and how it works. 

Why sharpen? 
Sharpening is necessary for several reasons, each of which imposes its own demands and sometimes 

those demands contradict each other.  Whenever we turn photons into pixels, we lose some sharpness, be-
cause no matter how high the resolution of our capture devices they sample a fixed grid of pixels, turning 
the continuous gradations of tone and color that exist in the real world into discrete pixels. Some lenses 
render the scene more sharply than others, but even the finest lenses still introduce some softness.  Some-
times we want to make the image sharper than it really was, to tell a story, make a point, or emphasize an 
area of interest. Sharpening can be used as a creative tool.  Sharpening is needed because output devices 
also introduce some softness. When we turn pixels into halftone dots or stochastic dithers of inks, or even 
into continuous-tone dots on dye-sub printers or film recorders, we lose sharpness again. 

We need to apply sharpening to counteract the softness introduced by both capture and output, and to 
satisfy our creative goals. 

The Sharpening Problem 
When we try to use a single round of sharpening on a digital image, we immediately encounter a prob-

lem. The image source requires one kind of sharpening, the image content needs another, while the output 
medium needs still another sharpening treatment. Why is this? 

•	 Different capture mechanisms—film formats and digital cameras—have their own signature combi-
nations of detail and noise. The challenge is to sharpen the detail without exaggerating the noise, so 
successful sharpening must take into account the relationship between image detail and the noise of 
the image source, whether film grain or a digital camera filter mosaic. Incorrect sharpening can make 
the grain or noise more, rather than less, obvious. 

•	 Different subjects need different treatments. Apparent sharpness depends on the contrast along what 
we see as edges. A close subject with soft detail such as a head shot has wider edges than a high-fre-
quency image such as a forest full of trees, so each requires a different treatment in terms of sharpen-
ing radius. Incorrect sharpening either obscures small details, or oversharpens textured areas such as 
skin tones. 

•	 Output processes differ in the way they render the conversion from pixels to printed dots, so sharp-
ening that works well for an inkjet printer may fail when sent to a halftone output process such as a 
web press, or to a continuous-tone process like a film recorder. Incorrect sharpening either produces 
insufficiently-sharp results, or makes obvious sharpening haloes along high-contrast edges. 
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No matter how hard we’ve tried to reconcile these three demands in a single round of sharpening, we’ve 
never been happy with the results. Independently, several of the PixelGenius team had developed a two-
pass approach to sharpening—performing a round of gentle sharpening close to capture time, and a second 
round tailored for the specific output process—but we each did things a little differently, proceeding as much 
by instinct as anything else. 

To create PKS2, we first analyzed what we had been doing independently, then we tested thousands of images 
from different sources and sent them to a variety of outputs. The result is PhotoKit  SHARPENER 2.0. 

The Sharpening Workflow Solution 
The solution, a well-thought-out sharpening workflow, is relatively simple in concept. Rather than try to 
address all the factors that influence sharpening in a single edit, the sharpening workflow splits sharpening 
into three stages. 

The benefit of dividing sharpening into these three phases is that it lets us handle the various competing 
needs separately. Capture Sharpeners compensate for the image source and image type without having to 
worry about output issues. Creative Sharpeners apply directly to the image at hand without having to worry 
about image sources (since they’ve already been handled by the Capture Sharpeners). Output Sharpeners 
concentrate solely on the needs of the output process (since the image has already been sharpened adequately 
in the two previous phases). 

The three sets of sharpeners have been carefully tuned to work together. You can archive images that have 
had Capture Sharpening and Creative Sharpening applied; then, when you want to produce a printed or web 
version of the image, you can simply resize to the required dimensions, apply the appropriate Output Sharp-
ener and output the file. This provides three key benefits: 

•	 Capture Sharpening is applied early in the image-editing process, and aims simply to 
restore any sharpness that was lost in the capture process

•	 Creative Sharpening is usually applied locally to accentuate specific features in an 
image—for example, we often give eyes a little extra sharpness in head shots. 

•	 Output Sharpening is applied to files that have already been sized to final output 
resolution, and is tailored to a specific type of output process. Output sharpening has 
one specific purpose - to compensate for dot-gain.

The PhotoKit SHARPENER 2.0 workflow modules.
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The PhotoKit SHARPENER 2.0 Advantage 
Many other great sharpening tools are available to Photoshop users, but PKS2 is the only one designed 
from the ground up to provide a complete sharpening workflow. And PKS2 offers some other significant 
advantages.

Non-Destructive Sharpening 
All sharpening effects are implemented as Layers or Layer Sets leaving the source image untouched, whether 
it’s a flat file or a complex layered construction. Sharpening effects remain non-destructive and adjustable 
until the user flattens the layered image or merges the sharpening effects into a normal pixel layer. 

Automation 
PKS2’s default settings are designed with automation in mind. You can utilize its built in Batch Mode to apply 
multiple effects without worrying whether or not it will wreck your images. 

Control 
Most sharpening tools offer a take-it-or-leave-it result. PKS2 produces layers at default opacities that allow 
you to increase or decrease the amount of sharpening after you’ve run the effect. For even more control, the 
Capture and Output Sharpener effects return separate layers for the light and dark sharpening contours. 
Additionally, those Capture Sharpeners that apply Smoothing do so on a third separate layer. Finally, for even 
more control, all PKS2 modes are configured to be allowed to create a layer mask with each effect, allowing 
further fine-tuning by editing the layer mask. 

•	 Ease of use. At each stage of the sharpening workflow you can make relatively simple 
decisions rather than try to address all the sharpening issues with a single edit. You can 
even automate large parts of the sharpening workflow by writing Photoshop Actions to 
call the individual Sharpeners. 

•	 Optimal sharpening. Addressing each sharpening issue separately means that you can 
produce much better results than would be possible using a single round of sharpening, 
so your output is tack-sharp, without obvious and offensive sharpening haloes. 

•	 Repurposability. Uncoupling output sharpening from the rest of the sharpening 
process means that you can keep a single version of the image and simply produce 
different versions, optimally sharpened for output, when you need them. 
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PhotoKit SHARPENER 2.0 New Feature Highlights and User Interface

PixelGenius has worked hard to add new features 
and address previous users’ requests. As a result, 
we have redesigned the user interface (UI) to take 
advantage of what we call the PixelGenius Toolbox. 
First introduced with the release of PhotoKit Color 

2, the Toolbox UI provides for an image preview as 
well as additional functionality as shown in the figure 
below. The red letters highlight the changes and 
additions.

A - The new dialog window in PKS2 now includes a preview button that allows 
seeing a preview of the selected sharpening effect. The preview will only be accurate 
when the preview window is zoomed to 100%.

B - The cursor inside of the preview window shows the area of the image that will 
be zoomed in when you click the mouse.

C - New to PKS2 (but previously available in PhotoKit Color 2) is the ability to have 
effects with multiple layers and layer groups returned as a single combined pixel 
layer. This feature can help keep file sizes down although it does impact the flexibil-
ity of individual layer adjustments after an effect has been applied.

D - The Create Layer Mask options allow all PKS2 effects to be brushed in or out 
depending on the Hide or Show effect options. The Hide Effect returns a layer with 
a layer mask set to black. The Show Effect returns a white layer mask that shows the 
final effect. To paint in an effect with a Hide Effect layer mask, paint with white. To 
remove the effect on a Show Effect layer paint with black.

E - The Show Batch Options allow stacking multiple effects to be run one after the 
other. So if you have a common capture, creative and output sharpening series you 
use, you can add those effects to a batch list. The batch list can be saved and loaded.

The basic PhotoKit SHARPENER 2.0 dialog window.
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To use PKS2, first select the Module, then the Set 
and finally the Effect as shown in the figures above. 
Generally, the Capture Sharpener would be the first 
step in a sharpening workflow unless you’ve already 
done capture sharpening in a separate application 
such as Camera Raw. The Creative Sharpener is 

usually used to make local sharpening or smoothing 
adjustments. The last stage of sharpening would be for 
the final Output Sharpener after all other sharpening 
rounds and after the image dimensions and pixels per 
inch have been determined.

Selecting the Toolbox Module for
Capture Sharpener 2.

Selecting the Set under the
Creative Sharpener 2 Module.

Selecting the Effect under the Inkjet 
Output Sharpeners, Set. 

Toolbox Module, Set and Effects

The PixelGenius Toolbox provides for a preview 
of the selected Module, Set and Effect. You should 
note, however, the Preview is only accurate when the 
Preview has been zoomed into 100% (one screen pixel 
for each image pixel). When you move the cursor 
around the Preview you’ll see a cursor that includes 
the magnify icon as well as a white rectangle that 
shows where the 100% Preview will be selected and 
shown. Clicking in the zoomed out image will sample 
that area and accurately preview the selected Effect 

in the zoomed in Preview. Once Previewed, you can 
zoom back out by clicking in the Preview window 
again.

Because PKS2’s effects are complicated and 
processor intensive, we don’t allow scrolling in the 
zoomed in Preview. However, zooming out of one 
area and zooming back into a new area is fast. We 
suggest practicing with the zoom function to get the 
hang of using it.

The Toolbox Preview

Close up figure of the Preview showing the entire image 
and the 100% zoom cursor.

Close up figure of the Preview at 100% zoom. Note the 
cursor changes to the minus magnify icon.
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The Create Layer Mask option allows you to 
automatically add a layer mask set either to Show 
Effects (white layer mask) or Hide Effects (black layer 
mask). The only functional difference is whether 
or not you want to paint in or out an effect. In the 
figures below, the left Layers panel shows the result of 

applying a Super Sharpener 1 effect from the Creative 
Sharpening  set with a Show Effect option. The middle 
figure shows the Hide Effect result. The figure on the 
right shows the result of painting in the layer mask to 
isolate the effect to the center of the image.

The Create Layer Mask Option

The Merge Results Option

Selecting the Merge Results option will condense 
down all of the various layers PKS 2 may produce into 
a single pixel layer as shown below. In this example, 
an Inkjet 240 Glossy layer group containing two layers 

has been combined into a single PixelGenius Toolbox 
Layer. This can provide considerable file size savings 
but does limit flexibility because the individual layers 
are combined.

Layers panel showing individual layers 
and layer group.

Layers panel showing the result of se-
lecting the Merge Results option.

Layers panel showing the layer mask 
set to Show Effects.

Layers panel showing the layer mask 
set to Hide Effects.

Layers panel showing the layer mask 
painted to allow the effect to show 
through in the center of the image.
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Show Batch Options

Show Batch Options checked before adding any Effects. Note: the OK button and Pre-
view are unavailable until you actually add an Effect to the batch list.

To extend the workflow concept of PKS 2, we’ve 
designed a built in batch capability to the PixelGenius 
Toolbox. This allows you to select and add multiple 
effects not only from PKS 2 but also from PhotoKit 
Color 2 (you’ll need the most recent free update) and 
the upcoming PhotoKit 2. You select a Module, Set 
and Effect, and a Layer Mask choice just as you would 
normally but instead of running them, you use the 
Add button to put them into a batch list as shown in 
the figure below. If you inadvertantly add an unwanted 
effect simply highlight the offending effect and click 

“Delete”. In this example, 3 sharpening effects and two 
Layer Mask choices have been added to the batch list. 
You can also save a batch list and use it over again. 
The figure in the middle shows the Save Batch Set 
dialog where you can name the set. The lower right 
figure shows the Load/Delete Batch Sets dialog which 
is accessed by clicking on the Load button of the main 
PKS 2 dialog.

You can save as many batch lists as you wish although 
you can’t edit an individual list after it is saved. You’ll 
need to delete the list and create a new one instead.

The Show Batch Options with three 
sharpening effects and two Layer Mask 

choices already added.
The Save Batch Set dialog with the Set 

Name entered as High Res Batch.
The Load/Delete Batch Sets dialog. 
Clicking on the saved batch list will 
display the effects saved in the list.
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This image and graph depict an edge transition— from 40 to 
60 percent. Each tick mark across the bottom of the graph 
represents a column of pixels. 

After sharpening the transition is accentuated - It’s darker on 
the dark side and lighter on light side, creating a halo around 
the edge.

Sharpening is basically a very localized contrast ad-
justment. Increasing the contrast along edges in the 
image produces the appearance of increased sharp-
ness. 

If you’ve ever wondered why Photoshop’s principal 
sharpening tool, the Unsharp Mask filter, is called 
Unsharp Mask when the result is to make the im-
age appear sharper, the simple answer is that it repli-
cates an analog darkroom technique called unsharp 
masking. The original negative is duplicated, then the 
original and the duplicate are attached to one side of 
a transparent carrier (often a piece of window glass). 
When the enlarger is focused on the negative on the 
bottom of the glass, the negative on top acts as an 
out-of-focus, or unsharp, mask that increases the 
contrast along the edges in the image. 

Digital sharpeners simulate this effect by looking at 
each pixel, deciding whether or not it represents part 
of an edge and then increasing the contrast around it. 
The typical result is a sharpening “halo” along edges. 

Edges in images consist of lighter pixels contrasting 
with darker ones, so when that contrast gets exagger-

ated to increase the apparent sharpness of the edge, 
the resulting halo has darker pixels that we refer to as 
the “Dark Contour” and lighter pixels that we refer to 
as the “Light Contour”.

In an ideal scenario, the dark pixels are darkened 
to exactly the same visual extent as the light pixels are 
lightened. However, this ideal is rarely met in prac-
tice, so often we see some tonal shifting between the 
sharpened and unsharpened versions of the image. In 
many cases, this tonal shift is unobjectionable or even 
desirable, but we recognize that such judgements are 
highly subjective, so in PKS2 we provide the ability 
to adjust the strength of the light and dark contours 
independently.

This is a capability that we’ve long wished for in 
Photoshop. As it turns out, the capability was there 
all along, but finding it and rendering it usable re-
quired considerable ingenuity. Now that we have it, 
we wonder how we managed to do without it for all 
these years! 

Sharpening Basics
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 				    Original					                             Unsharpened detail at 200%

		      Capture sharpen at default opacities 		                            Light contour at 70%, dark contour at 45%

	
  

 

Controlling Dark and Light Contours
On this image the default sharpener settings darken 

the image slightly. Adjusting the opacities of the light 
and dark contours independently—to 70% for the light 

contour and 45% for the dark contour—produces a 
result that’s sharp, but is closer to the original tonal 
values. 

The Layers panel showing the sharpened image above. The default 
opacity is 66% but you can adjust it to modify the sharpening halos. 
In the example above, the Light Contour has been adjusted to 70%.
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PhotoKit SHARPENER 2.0 Menus 
As we explained earlier, good sharpening has to 

take into account the characteristics of the capture 
medium, the content of the image and the properties 
of the output device. Addressing all these issues in a 
single round of sharpening is, we believe, impossible, 
so PKS2 divides sharpening into three phases: Capture 
Sharpen, Creative Sharpen and Output Sharpen. 
The three sharpening phases appear as separate 
commands on Photoshop’s Automate submenu, 
PhotoKit Capture Sharpener…, PhotoKit Creative 
Sharpener…, and PhotoKit Output Sharpener…
arranged in the order in which they’re typically used.  

For best results we recommend starting out with 
unsharpened files (turn off any sharpening in the 
scanner or capture software) and using PKS2 to 
apply all sharpening. Turning off sharpening in 
scanner or camera capture software isn’t always easy, 
though we haven’t yet encountered a case where it 
was impossible. If Capture Sharpening oversharpens 
images, it’s likely that some sharpening is being 
applied beforehand, in which case you’ll need to dig 
deeper into your scanner or camera capture software 
to find the Off switch!

The figure at the bottom of the page shows the 
PixelGenius Toolbox Module drop down menu with 
not only PhotoKit SHARPENER 2 but also PhotoKit 
Color 2 and the new PhotoKit 2 (due 1st. Quarter, 
2011). The ability to select any of the PixelGenius 
PhotoKit products allows you to combine and mix 
& match effects from any of our products. This is 
particularly useful when combining effects across 
multiple products when using the Batch Options.

PhotoKit SHARPENER 2.0 Image Requirements 
PKS2 has only two requirements for images. 

Images can be in 8 or 16-bit mode
Images can be in Greyscale or RGB mode

PhotoKit SHARPENER 2 does not support:
CMYK, Lab nor Indexed color spaces.

The basic PixelGenius dialog with the Module menu shown expanded down showing PhotoKit Color 2, the three 
PhotoKit SHARPENER 2 modules and PhotoKit 2 (due the first quarter of 2011). Note, it doesn’t matter which Mod-
ule you select in the Automate menu, all installed Modules are still available in the drop down menu.
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Capture Sharpeners 
Capture Sharpeners are designed to apply gentle 

sharpening early in the workflow. The sharpening 
is concentrated in the midtones, applying relatively 
little sharpening to shadows and highlights (no 
sharpening is applied to pixels lighter than level 250 
or darker than level 10). That way, there is sufficient 
“headroom” to apply sharpening tailored for different 
output processes, while allowing you to work on a 
reasonably sharp image. The Capture Sharpeners 
may be gentler than the sharpening techniques you’re 
used to, but when they’re combined with Output 
(and, optionally, Creative) Sharpeners they produce 
very sharp results.  

Selecting a Capture Sharpener Set 
The Capture Sharpener sets are named for the 

image source. The film sets are effective at almost 
any scanning resolution—the key factor is the 
relationship between the edges you wish to sharpen 
and the inherent noise structure (grain) of the film. 
The Digital Capture sets are organized by capture 
size and by the degree of smoothing they apply, from 
least to most. Unless it’s obvious that an image needs 
smoothing (it already has visible noise or artifacting), 
we recommend that you first try the Auto option.

The amount of noise present in a digital image 
usually correlates with the ISO speed at which the 
image was shot. But cameras vary widely in their 
behavior, so it’s difficult to provide a set of magic 
numbers that dictate when smoothing is required. 
As a general rule, it’s unlikely that images captured at 
400 ISO or slower will need smoothing, and equally 

unlikely that images captured at 1600 ISO or faster 
won’t require smoothing, but there’s a large gray 
area in between. The images on the following page 
are illustrative of varying degrees of noise, and show 
the effects of sharpening alone, and sharpening with 
smoothing.

Choose the Capture Sharpener set that corresponds 
most closely to your image source. The Capture 
Sharpener sets are described in more detail here:

35 Positive Film: for scans from 35mm positive film.

35 Positive Film METW: for scans from 35mm 
positive film of close subjects with soft detail and very 
wide edges, such as portraits. The METW (Modified 
Edge Transition Width) algorithms are designed to 
emphasize wide edges while minimizing grain.

35 Slow Negative Film: for scans from 35mm 
negative film at speeds of up to 400 ISO.

35 Fast Negative Film: for scans from 35mm negative 
film at speeds faster than 400 ISO.

6x6 Positive Film: for scans from medium-format 
positive film (6x6, 6x7, 6x9). 
               
6x6 Negative Film: for scans from medium-format 
negative film (6x6, 6x7, 6x9). 

4x5 Positive Film: for scans from large format 
positive film (4x5). 

4x5 Negative Film: for scans from large format 
negative film (4x5). 

A 35mm positive image with soft detail and wide edges may 
benefit from the 35 Positive Film METW sharpeners.

NOTE: If the image you have loaded into PKS 2 
has metadata indicating the image is from a digital 
camera, you won’t see the film based capture sharp-
eners. The film based sharpeners are only for scans 
from film. If you have an image without camera 
data you will see the entire list of the Set including 
sharpeners for film and digital capture.
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Sharpening and Smoothing 

Shown below are details from versions of the image 
at left, shot at 100, 400, and 800 ISO, unsharpened, 
sharpened, and sharpened and smoothed. The 
100 ISO image definitely does not benefit from 
smoothing; the 800 ISO image definitely does; while 
the 400 ISO image is a judgement call.

	
  

	
  

 

unsharpened sharpened sharpened and smoothed

100 ISO

400 ISO

800 ISO

Original Image
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Digital Low-Res Sharpen: for digital captures of up 
to approximately 4 megapixels (pixel dimensions of 
up to approximately 2500 x 1600) that are relatively 
free of noise and hence don’t require smoothing.

Digital Low-Res Smoothed Sharpen: for noisier 
digital captures of up to approximately 4 megapixels 
(pixel dimensions of up to approximately 2500 x 
1600) that require some smoothing in addition to 
sharpening.

Digital Mid-Res Sharpen: for digital captures of up 
to approximately 6 megapixels (pixel dimensions of 
up to approximately 3072 x 2048) that are relatively 
free of noise and hence don’t require smoothing.

Digital Mid-Res Sharpen and Smooth: for noisier 
digital captures of up to approximately 6 megapixels 
(pixel dimensions of up to approximately 3072 x 2048) 
that require smoothing in addition to sharpening.

Digital Mid-Res de-JPEG Sharpen and Smooth: for 
digital captures of up to approximately 6 megapixels 

shot as JPEG, that display obvious magenta-green 
JPEG artifacts as well as noise—see below. (We 
typically only see this on images shot at 800 ISO and 
above.)

Digital High-Res Sharpen: for digital captures of 8 or 
more megapixels (pixel dimensions of approximately 
4000 x 2700 and upwards) that are relatively free of 
noise and hence don’t require smoothing.

Digital High-Res Sharpen and Smooth: for noisier 
digital captures of 8 or more megapixels (pixel 
dimensions of approximately 4000 x 2700 and 
upwards) that require smoothing in addition to 
sharpening.

Scanning Back: for digital captures made with 
scanning back cameras at almost any resolution. The 
key difference between scanning backs and more 
typical one-shot digital cameras is that scanning 
backs capture real red, green, and blue data for every 
pixel, producing an essentially grain-less capture. 
 

	
  

 

	
  

 
Unsharpened De-JPEG Sharpen and Smooth
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Choosing a Capture Sharpener Effect

Auto Edge Sharpen analyzes your images and 
determines the optimal sharpening based on the 
the average frequency. We recommend that you try 
this first and then analyze the results. This selection 
will generally produce the best overall Capture 
Sharpening. However, in the unlikely event that 
the Auto sharpening adversely affects select areas 

of the image we recommend that you mask them 
out, temporarily turn off the Auto Edge Sharpening 
Group and then run the appropriate Edge sharpening 
for the masked out area. This effect should then be 
restricted to the area in question through the use of a 
mask. The Auto Edge Sharpening group should then 
be turned back on. 

In this example we have an image that needs both a Narrow Edge 
Sharpen (pine needles and fine branches) as well as a Wide Edge 
Sharpen for the subject. The Auto Sharpen Edges determined the 
optimal sharpening and in this case both the narrow and wide 
edges received an appropriate amount of Capture Sharpening.

Each Capture Sharpener set contains five effects tai-
lored to emphasize different edge widths, labeled 
Auto Edge Sharpen, SuperFine Edge Sharpen, Nar-
row Edge Sharpen, Medium Edge Sharpen and Wide 
Edge Sharpen, respectively. (The sole exception is 
scanning backs, where the images are so clean that 
there’s no need to emphasize edges and downplay 
non-edges.) 

Choosing between these five flavors of sharpening is 
not an exact science (if it were, we’d have a less am-
biguous naming convention) and is to some degree 
a matter of taste. Generally, the Auto Edge Sharpen 
will produce the best results, however, in some cases 
the use of one or two of the other four may render a 
better overall Capture Sharpening.
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SuperFine Edge Sharpen is designed for busy images 
with tiny details right at the limit of the capture medium’s 
ability to resolve as shown below. This effect is rarely 
needed, but we added it to PhotoKit SHARPENER 1.2 

after receiving a small but significant number of images 
from users who found that the Narrow Edge Sharpen 
effect was still too coarse and obscured useful detail.

	
  

 

These detail images show 
SuperFine Edge Sharpen, 
near right, and Narrow Edge 
Sharpen, far right.

Selecting SuperFine Edge Sharpen from
the Effect menu.

The layer group name reflects the Set: HRDC 
Sharp and the Effect: SF.
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Narrow Edge Sharpen is designed for “high-
frequency”, busy images with lots of tiny details shown 
below. The differences between Narrow Edge Sharpen 
and SuperFine Edge Sharpen are quite subtle, but 
unless you’re concerned with details around the single-
pixel level, Narrow Edge Sharpen is usually a better 
choice for high-frequency images than SuperFine 
Edge Sharpen.

Bear in mind that all the effects will sharpen all 
edges to some extent—the difference is simply one 
of emphasis. Each of the edge widths emphasizes a 
different general tendency in the image. Once you 
gain some experience using PKS2, you’ll find that 
it’s relatively easy to match the effect to the image to 
produce the results you want.      

	
  

 

These detail images show Narrow Edge 
Sharpen, near right, and Wide Edge 
Sharpen, far right. The Wide Edge 
Sharpen actually obscures some of the 
finer details and produces wide sharp-
ening contours that look unnatural.

Selecting Narrow Edge Sharpen from
the Effect menu.

The layer group name reflects the Set: HRDC 
Sharp and the Effect: N.
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Medium Edge Sharpen is designed for “normal” 
images, like the examples shown here. 

Selecting Medium Edge Sharpen from
the Effect menu.

The layer group name reflects the Set: HRDC 
Sharp and the Effect: M.
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Wide Edge Sharpen is designed for close subjects with 
relatively soft detail, where the goal is to emphasize edges 
without applying significant sharpening to textured areas 
like skin, as in the examples shown below.

Selecting Wide Edge Sharpen from
the Effect menu.

The layer group name reflects the Set: HRDC 
Sharp and the Effect: W.
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Auto, SuperFine, Narrow, Medium, and Wide Edges Compared

On any single image, the differences between Auto, SuperFine, 
Narrow, Medium, and Wide Edge Sharpen may be quite subtle. The 
image details below show the same image with Auto, SuperFine, 
Narrow, Medium, and Wide Edge Sharpen applied. The example 
below illustrates just how subtle the Capture Sharpening is. The 
Difference image is a Calculation that shows where the Auto 
Sharpen has enhanced the image. Although it’s barely perceivable 
by the eye, on a pixel level it’s significant.

SuperFine Edge Narrow Edge Medium Edge Wide Edge Auto

Original Capture Auto Sharpen Difference
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All PhotoKit products, including PKS2, follow 
the same basic rules. First and foremost, PhotoKit 
never harms the original image. All PhotoKit effects 
are applied on additional layers, leaving the original 
source image untouched. Second, PhotoKit effects 
offer great flexibility by using all currently visible 
layers as the source for the effect.

This lets you control exactly how effects are applied. 

For example, if you want to compare two different 
effects—two different Capture Sharpeners, for 
example—you simply run the first effect, then turn 
off the visibility for that effect in the Layers palette 
before running the second one.

 

Run the first effect, then ... Run the second effect, then ...

hide the result.      compare the results by 
turning each layer set 
on and off.

Comparing effects

Comparing Sharpening  Results

NOTE: PhotoKit SHARPENER 2 will use all vis-
ible layers when applying the effects. If you don’t 
wish for a layer to be included in the processed 
result, simply un-check that layer or layer group.
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If, on the other hand, you want to look at the 
cumulative result of running two effects, you can use 
SHARPENER’S Batch Mode. Batch Mode allows the 
user to add multiple effects and apply them all with 
one click. The resulting effect will be cumulative. 

A possibly non-obvious consequence of this 
behavior is that when you want to add layer-based 
edits (for example, a Curves or Hue/Saturation 

Adjustment Layer) to an image that already contains 
one or more PhotoKit effects, you should add the 
new adjustments at the top of the layer stack, above 
the PhotoKit effects, rather than underneath them in 
the Layer stack. 

Select the “Show Batch Options” then choose the 
first effect and click “Add”.

Select the next desired effect and click “Add”. When 
you have finished selecting effects click “OK” and the 
cumulative effects will be render and appear in your 
Layer Stack.       

Stacking effects

View the cumulative results.
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Post-Effect Controls
After you’ve run the effect, PhotoKit returns a 

Layer Set, named for the effect, that contains a Light 
Contour   layer (A.), a Dark Contour layer (B.), and 
in some cases, a Smoothing Layer (D.). This allows 
for substantial tweaking of the sharpening effect 
after it has been applied.

Layer Opacity: You can vary the strength of the 
effect by adjusting layer opacities using the Opacity 
slider (C.) in the Layers palette.

The Sharpening Layer Set always appears with 
100% opacity. You can reduce the strength of the 
sharpening by lowering the opacity of the layer set. 
The individual Light and Dark Contour layers for 
Capture Sharpeners always appear with a default 
opacity of 66%, so you can increase or decrease the 
strength of the light and dark contours independently 
by varying the respective layer opacities.

You may find that you often want to reduce the 
opacity of the smoothing layers, or even turn them 
off entirely. But the sharpening layers are based on 
the result of the smoothing layers, so even if you 
wind up discarding them, they’ve still played a useful 
role.

Layer Masking: To localize the sharpening effect 
you add a layer mask to the Sharpening Layer Set by 
selecting “Create Layer Mask” checkbox “E.” in the 
PKS2 dialog. You can also select whether you want 

to create a mask to hide the effect (black mask), or a 
mask that reveals the effect (white mask). Click the 
layer mask’s tile to activate it for editing. It’s active 
when the icon has border. You can now paint in the 
effect (Hide Effect / Black Layer Mask) using a white 
brush or you can paint out. (Show Effect / White 
Layer Mask) using a black brush.

So Where Are The Sharpening Brushes?
Previous versions of PhotoKit Sharpener 
have included options that would allow the 
painting in of or out of the sharpening effect. 
This functionality has not been removed 
but rather extended to all effects available in 
PKS2. 

A.

B.

C.

D.

E.
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In PKS2 we preserve the mask through which 
sharpening is performed as a layer mask. Layer masks 
control the visibility of the layer to which they apply: 
white in the layer mask makes the layer fully visible, 
black hides, intermediate grays make it partly visible. 
Editing the layer mask allows you to fine-tune the 
effect of the Sharpening layer. One very easy way to 
fine-tune the sharpening is to adjust the contrast of 
the Layer mask using Levels (Curves works too, but 
Levels offers the advantages of speed and simplicity). 
In the example shown here, we pull the white input 
slider down, creating more white pixels in the Layer 
mask, and hence more sharpening. On the Light Con-
tour layer, we also make a midtone adjustment using 
the gray slider to darken the midtones, compensat-
ing for the white slider move so that areas we want to 
leave unsharpened are indeed left that way.

The simple rules to follow:
•	 Adjusting the black input slider in Levels creates 

more black pixels and protects more of the image 
from the effect.

•	 Adjusting the white input slider in levels creates 
more white pixels and applies the effect to more 
of the image.

•	 Adjusting the gray input slider in Levels changes 
the slope between pixels that are affected and 
pixels that are protected.

Capture Sharpen
The Capture Sharpener set is designed so those users 

who want the ultimate in control can fine tune the 
effect. The example shown here is relatively unsubtle—
we wanted to make sure that the before-and-after 
difference is obvious. Use them only when you want 
to make subtler changes than can be achieved by 
adjusting the layer opacities.
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Flattening the Capture Sharpen Layer Set
Once you’re happy with the results of the Capture 

Sharpener, you may wish to flatten the layer set to 
reduce the file size and the concomitant demands 
on memory, scratch disk space and storage. You can 
either flatten the image, which burns all the changes 
into the Background layer, or, if you wish to keep 
your Background layer intact, merge the effect into a 
new layer. The trade-off in doing so is that you make 
a smaller file, but you lose the ability to edit since 
you no longer have separate sharpening layers. We 
recommend that you always flatten images before a 
mode change—from RGB to CMYK, for example—
but you needn’t do so for RGB-to-RGB conversions.

Flattening the image: Choose Flatten Image from 
the Layer menu. All layer-based edits are burned into 
the Background layer and the individual adjustment 
layer and layers are deleted.

Merge to a new layer: Choose Merge Visible 
from the Layer fly-out menu while holding down 
the Option (Mac) or Alt (Windows) key, or press 
Command-Option-Shift-E (Mac) or Control- Alt-
Shift-E (Windows). The sharpened image is merged to 
a new layer. Finally, delete the sharpening Layer Set to 
reduce the file size.

Creative Sharpeners
The Creative Sharpeners are designed to apply to 

images after running Capture Sharpeners and before 
Output Sharpeners. By nature, the primary use of 
Creative Sharpeners is for localized sharpening or 
smoothing of areas in an image. While most images 
may fall into one of the primary categories we’ve chosen 
such as Narrow, Medium, and Wide edges, in general 
all images exhibit some cross-category tendencies. 
Additionally, the content of an image may dictate that 
certain areas of an image need more sharpening or 
even more smoothing, to optimize the composition.

The Creative Sharpening effects are divided into 
three sets: Sharpening Effect, Smoothing Effects, and 
Special Effects.

Warning: As with all sharpening effects, you should 
understand that it is possible to oversharpen an im-
age and therefore ruin it. We suggest the user take a 
subtle approach when using the Sharpening Effects. 
However, also remember that all PhotoKit 2.0 effects 
return fully editable layers that can always be low-
ered in opacity or turned off, so we encourage you to 
experiment and see how far you can push the effect.

Sharpening Effects Set
The Sharpening Effects Set is a collection of heavy 

duty effects. These effects can be previewed on-screen 
by checking the Preview checkbox.



25

Sharpening Effects
The Sharpening Effects return a layer with the 

sharpening effects applied to the pixels of the layer. As 
with all PhotoKit 2.0 Effects you can choose to include 
a white (Show Effect) or black (Hide Effect) layer mask. 
If you choose a black mask (Hide Effect) you can paint 
in sharpening to selected areas of your image. You, the 
user, need to actively reduce the overall opacity of the 
layer masks brush yourself. An easy keyboard method of 
changing a brush’s opacity is to simply press a number 
key after the effect is run. Pressing the 5 key will give 
you 50% opacity, a 3 gives 30%. We suggest using an 
opacity of between 10%-30% for gentle buildup of 
effects and a 50% opacity for a quick buildup.

Remember, you can always paint away the effect by 
selecting black as the foreground color, so you can 
always adjust your final blend very precisely. An easy 
way to toggle between White/Black and Black/White is 
to type the “x” key. This exchanges the foreground and 
background colors.

The Edge Sharpen effects apply sharpening only 
to simple edges in three strengths from 1–3. The 
Luminance Sharpen has an additional strength and 
applies sharpening only to the luminosity of an image, 
while the High Pass Sharpen effects use an Overlay 
blend mode to enhance edge halos. The Dimensional 
Sharpening applies an inverted Luminosity mask to 
a modified High Pass Sharpen effect to restrict the 
amount of sharpening according to tonal content. 
Darker areas get more sharpening than lighter areas. 
All Sharpening Effects result in global sharpening 
over the entire image, but they can be manipulated 
by adjusting the default 66% layer opacities, or by 
including a layer mask.

Also included in the Sharpening Effects is Super 
Sharpener in varying strengths. The Super Sharpeners 
are special purpose tools— use them with caution. If 
your image is already sharp, these effects may indeed 
vastly oversharpen those areas in your image. But the 
Super Sharpeners can actually create textural detail 
where none was visible before. In general, you should
use these effects at the default opacity of 50% or less. 
Also, be sure you examine sharp-edged areas of your 

image and include a layer mask to locally reduce the 
opacities or use the eraser tool to eliminate those areas 
in your image that break.

The Super Grain effects add a digital replication of 
photographic film grain while sharpening an image. 
These grain effects can be usefully applied over re-
touching to help integrate the overall textural appear-
ance, and hide irregularities. Adding a low level of 
photographic grain to digital captures can also make 
the capture look more “film-like”. As with all of the 
Creative Sharpeners, you should use judgement and 
self-discipline to resist over-applying these effects. Re-
member, while the image is still in layer form, you can 
exercise enormous control over the flavor and strength 
of sharpening or smoothing, but once it’s flattened, you 
can’t undo the effects. Also remember to leave some 
headroom for the final stage of the sharpening work-
flow, the Output Sharpeners, which will handle desti-
nation-specific sharpening requirements.

The Smoothing Effects
The Smoothing Effects apply a gentle low level 

blur  or contrast reduction that can be very useful for 
smoothing skin or other areas of unwanted texture.

We’ve also included four special smoothing effects 
for solving specific image problems. The Edge-Protect-
ed Smoothing, and the Edge-Protected Smooth Noise 
only apply their effects to non-edge areas of the im-
age, so you can apply the smoothing to large open ar-
eas without the nned for special layer masks to protect 
the edges. The Detail Subtractor reduces local contrast 
to “smooth out” detail and texture. The Edge-Pro-
tected Smooth Noise has the added benefit of adding 

Warning: When using Layer Masks, if you select and 
activate a different layer, and then return to the pixel 
layer with the layer mask, be sure to click on the actual 
layer mask to target the mask and not the pixel layer. 
Otherwise, the painting will be applied over your pix-
els instead of on the mask. 
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back in a low level of soft noise or grain that can help 
when working on images with higher ISOs. The  JPEG  
Smooth  effects  help  mitigate  the  noisy magenta-and-
green shadow artifacts found with some cameras.

The Special Effects
These are effects that fall outside of traditional 

sharpening or smoothing effects.

Midtone Contrast effects enhance tonal separation  
and help combat dot-gain when outputting your 
images to print. Select the effect that most closely 
reflects your target midtones. The effect layer  defaults 
to 20% opacity. The effect generally works best between 
20 - 40% opacity so if you decide to use a higher setting 
be sure to  check the results for unwanted “halos”. \

Negative Midtone Contrast effects “flatten” the 
midtones and reduce the contrast of the midtone 
values. The same setting considerations outlined above 
for the Midtone Contrast Effects apply here.

Fog effects apply a lightening blur effect, similar to 
shooting with a fog filter over the lens, so  highlights 
attain a soft glow. 

Diffusion effects apply a darkening blur, similar to 
applying diffusion over an enlarger lens when making 
B&W prints, so the shadows expand and you see a 
“dark glow” around shadows.

HazeCutter effects add a warming color correction 
to sharpening that can particularly help images where 
aerial haze causes both softening and cooling color 
balance in distant scenes. This group includes an Auto 
function which generally produces the best results.

Depth of Field effects have the ability to add 
additional edge sharpening above and beyond 
traditional sharpening. While it’s impossible to make 
an out of focus object appear to be “in-focus”, the 
DOF Effects add as much edge contrast as possible 
and can indeed considerably improve soft areas of 
an image. This group also includes an Auto function 
that generally produces the best results. One trick to 
making an area of an image appear sharper is to add 
a suggestion of softness elsewhere in the image. While 
applying a Sharpening effect to a person’s eyes and lips, 
for example, you may add smoothing to skin or other 
areas you wish to de-emphasize using a Smoothing 
effect. 

Dimensional Noise effect adds noise to an image 
filtered through an inverted luminosity mask. This 
allows increased noise in the shadows and reduced 
noise in the highlights and eliminates the visual 
“flattening” that can occur when adding a single, global 
noise layer.

Super Grain effects add a digital replication of 
photographic film grain while sharpening an image. 
These grain effects can be usefully applied over 
retouching to help integrate the overall textural 
appearance, and hide irregularities. Adding a low 
level of photographic grain to digital captures can also 
make the capture look more “film-like”. As with all of 
the Creative Sharpeners, you should use judgement 
and self-discipline to resist over-applying these effects. 
Remember, while the image is still in layer form, you can 
exercise enormous control over the flavor and strength 
of sharpening or smoothing, but once it’s flattened, 
you can’t undo the effects. Also remember to leave 
some headroom for the final stage of the sharpening 
workflow, the Output Sharpeners, which will handle 
destination-specific sharpening requirements.
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The Output Sharpeners are designed for images that 
have already had Capture and Creative Sharpeners 
applied. The last step of the sharpening sequence is to 
“crisp” up the image to help compensate for the dot-
gain of the printing process. Dot gain is an increase in 
dot size over the original due to the spreading of the 
ink droplet in the printing process. Matte papers tend 
to exhibit more dot gain than photographic surface 
papers. Although we allow the user to “Preview” the 
sharpening amount it’s an inaccurate view at best. 

Screens don’t show dot gain so the only accurate 
prediction is a proof print. The PixelGenius team 
has printed thousands of prints to test the output 
sharpening settings and we feel confident that they 
will produce optimal result in most cases. The Output 
Sharpeners are divided into four sets to address 
four different types of output; Contone Output 
Sharpeners, Halftone Output Sharpeners, Inkjet 
Output Sharpeners, and Web and Multimedia Output 
Sharpeners. 

The Contone Output Sharpeners are designed 
for final output sharpening of images destined for 
continuous-tone printing processes such as dye-
sublimation and photographic printers. The effects 
are organized by resolution in pixels per inch at 
final output size. Some continuous tone printers 
will downsample file resolution to match the device 
resolution, so if your image resolution is significantly 

higher than the device resolution your sharpening 
may not be optimal. For best results, we recommend 
resampling images to the specific pixel resolution 
of the device, but if its only slightly off— 308 ppi 
for a 300-ppi device, for example, it’s probably OK 
to apply the 300-ppi sharpening and send the file 
without resampling. Simply choose the closest Output 
Sharpener to the file’s actual resolution. 

Output Sharpeners

NOTE: The Units shown in the Contone, Inkjet 
and Halftone Sharpeners reflect the Units current-
ly set in Photoshop. As shown in the figure above, 
the Unit readouts are in pixels. To change the Unit 
Readout select Panel Options from the flyout menu 
and change it in the Ruler Units drop down menu as 
shown on the right.



28

The Inkjet Output Sharpeners are totally automatic 
requiring the user to select either Glossy or Matte in 
the Effect dropdown menu. The matte effect applies 
slightly stronger sharpening than the glossy effects. 
Our experience suggests that luster and semigloss 
papers behave more like glossy than matte, but it’s 
a good idea to run some tests on any specific paper 
you use a lot. As with the other Output Sharpeners, 
the Inkjet Output Sharpeners allow for considerable 
post-effect tweaking to optimize for a specific paper 
stock. REMEMBER: You adjust the intensity of the 
effect by altering the opacity of the sharpen set or the 
individual Light Contour or Dark Contour layers.

One of the new features of PKS 2 is the ability to 
resize your image without resampling directly in the 
Contone, Inkjet and Halftone Sharpeners. This allows 
more control over the final printed dimensions of your 
image while still automatically getting the optimal 
output sharpening. 

In the figure above the original image was 9.61 x 
7.08 at 360 ppi and 240 ppi had been entered into 

the Resolution. That would have resulted in an image 
whose dimensions were 14.4125 x 10.6167 at 240 ppi.

But what if you wanted a print that was 5 x 7 inches? 
In the figure on the lower left the Width has been 
highlighted. On the figure on the lower middle, the 
Width has been changed to 7 inches. This will change 
the Resolution to 494.286 ppi. This isn’t a problem!  
The actual resolution of the image in pixels/unit 
doesn’t matter for printing processes as long as it’s 
within a certain range. It’s far better to specify the 
dimensions and let the ppi fall where it may. Generally 
we suggest keeping the native resolution of your file 
and simply change the dimensions of the image to get 
the image dimensions you need. As long as the final 
image resolution is between 180-480 ppi (or above) 
you should get good results in your final print.

After running the output sharpener, your image 
will have the size specified in the Message area of the 
output sharpener and the sharpening will be applied 
at the final pixel/unit resolution.

The Width text field is highlighted with the 
current dimension of 14.4167 showing.

The Width has been changed to 7 inches. The 
Height automatically changes to maintain 
the same image proportion as the original 
and the Resolution is now 494.286 ppi. The final Inkjet Output Sharp-

ener layer group shows the name 
and resolution–in this case it’s 
480+. The plus sign indicates the 
resolution is over 480 ppi.
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Note: The Output Sharpeners for print processes— Contone, Halftone, and Inkjet are likely to produce re-
sults that can appear quite ugly on screen when viewed at zoom levels of Actual Pixels or higher. They will, 
however, produce excellent results in the final print. Bear in mind that, depending on the print process and 
the pixel density, it may take up to four pixels to produce a single dot of ink, so the Actual Pixels view can be 
very misleading. You can get a better idea of the final appearance by viewing the image at 50% or even 25% 
view (avoid the “odd” zoom percentages such as 66.7% and 33.3% because Photoshop applies heavy anti-
aliasing to those views), but the only way to really see the result is by viewing the final print.

The Halftone Output Sharpeners are designed 
for final output sharpening of images destined for 
output processes that use a conventional halftone 
rosette, such as the majority of printing presses as 
well as dot-based digital proofing systems such as 
the Kodak Approval. In addition, some color laser 
printers and some inkjet printers driven by RIPs use 
conventional halftone rosettes.

The key parameters for halftone output sharpening 
are: coated or uncoated paper stock, the frequency of 
the line screen expressed in lines per inch (lpi) and 
the pixel resolution at final output size in pixels per 
inch (ppi). Uncoated papers generally benefit from 
a slightly stronger sharpening than coated ones. The 
interaction between pixels and halftone dots, which 
is dictated by the Quality Factor—the relationship 
between pixel resolution and screen frequency—is 
key to sharpening the pixels that produce the desired 
halftone dots.

The Halftone Output Sharpeners are organized 
by screen frequency (lpi), coated vs uncoated stock, 
and resolution in ppi. For each supported screen 
frequency, we offer a set that corresponds to a Quality 
Factor of 2 - a resolution of double the line screen 

- which is typically used for premium work, and a 
Quality Factor of 1.5 - a resolution of 1.5 times the 
line screen - which is often used to save storage space 
and transmission time on less-critical work. We don’t 
recommend using a Quality Factor of less than 1.5 
for halftone output. We recommend using a Quality 
Factor of 2 when the image contains fine diagonal 
lines or contains many important small details, but a 
Quality Factor of 1.5 is sufficient for most work.

If figuring out what 1.5 times the line screen is for 
a 133-line screen makes your brain hurt, note that 
we’ve done the math for you. For each line screen, 
the lower ppi value corresponds to a Quality Factor 
of 1.5, and the higher one corresponds to a Quality 
Factor of 2.

While we advocate maintaining the native 
resolution of your image for Contone or Inkjet 
printing the same can’t be said for Halftone printing. 
While getting the EXACT resolution still isn’t 
mission critical, you should at least be close to the 
typical range of 1.5-2.5 the lpi of the halftone screen. 
Sending too much resolution to halftone will result 
in soft images even if sharpened. That is the reason 
we suggest 2X the lpi.
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The Web and Multimedia Output Sharpeners 
are designed to apply a final sharpening to images 
destined for on-screen viewing on the Internet, CD-
ROM, multimedia kiosks, or for any other situation 
where the display is the final output.

The Web and Multimedia Output Sharpeners 
resemble the Capture Sharpeners more than they do 
the other Output Sharpeners in that they are organized 
in terms of pixel dimensions and SuperFine, Narrow, 
Medium, or Wide Edges.

The pixel dimension refers to the width of the 
image in pixels. The criteria for choosing SuperFine, 
Narrow, Medium, and Wide Edge Sharpen are the 
same as for the Capture Sharpeners. In the vast 
majority of cases, you’ll want to use the same choice 
of edge width on both the Capture and the Web and 

Multimedia Output Sharpeners.
Unlike the Contone, Inkjet and Halftone 

sharpeners that can resize without resampling, the 
Web and Multimedia Output Sharpeners can actually 
resample your image.  The type of resampling or 
image interpolation will depend on your Photoshop’s 
Preferences as shown in the figures below. Simply 
enter in the desired pixel dimension you want for the 
final output. The resampling will be done and then 
the image will be sharpened. Note: we suggest using 
Save for Web and Multimedia in Photoshop when 
saving images intended for the web. The actual ppi 
of your image won’t matter after using Save For Web. 
We also suggest converting to sRGB before changing 
the image mode from 16 bits/channel to 8 bits.

The Web and Mutlimedia Output Sharpeners  
use whatever image interpolation that is cur-
rently set in Photoshop’s Preferences. If you are 
doing a large downsample, we suggest using Bi-
cubic Sharper which is designed for down-sam-
pling. If the amount of resampling is a relatively 
low percent, we suggest the regular Bicubic.
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NOTE: The Batch Option checkbox is “sticky” and once checked it will remain checked until unchecked.    To 
return the single effect functionality simply uncheck the “Show Batch Options” checkbox. 

The Show Batch Options in PKS2 provides a 
solution for applying the entire sharpening workflow 
from Capture-> Creative-> Output from a single 
dialog. It also allows one to save preset workflows 
including PhotoKit Color 2 and PkotoKit 2 effects 
and easily apply them to similar images. 

The Batch Dialog Options become available once 
the Show Batch Options checkbox is checked. After 
the first effect is chosen in the Module, Set and Effect,  
the effect is added to the Batch Window by clicking 

the Add button. NOTE: the OK and Preview buttons 
are greyed out (not active) until you add at least one 
Effect. The selected effect will then appear in the 
Batch Window. Additional effects are then added and 
will appear in the Batch Window. When all desired 
effects are added, clicking the OK button will run 
the batch. The combined effects can be Previewed 
by checking the Preview Button.  To insure a more 
accurate Preview click on the Preview window to 
view a selected portion of the image at 100%.   

Photokit Sharpener 2.0 Workflow Using the Show Batch Options

After selecting the Module, Set and Effect, click the Add but-
ton and that effect is added to the batch list. If you wish to 
delete an effect, highlight the effect and click on the Delete 
button.

You can continue adding additional Effects by selecting an ad-
ditional Module, Set and Effect. Note that you’ll want to start 
with capture sharpening and will usually finish with output 
sharpening.
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	  In the above example the following effects were added to the batch list set:
	 1. Photokit Capture Sharpener 2 - Digital High Rez Sharp using Auto Edge Sharpen
	 2. Photokit Creative Sharpener 2 - Special Effects - Midtone Contrast - Low
	 3. Photokit Output Sharpener 2 - Inkjet Output Sharpeners - Glossy (res-240)

Using this batch, the user has the option to Merge 
the result of all effects into a single layer by selecting 
the Merge Results checkbox. Additionally a layer 
mask to hide or reveal the results can be added by 
selecting Create Layer Mask. Note that you must 
select the Merge Results checkbox in order to 
enable the Create Layer Mask option. Any batch 
can be saved and reused later by using the Save and 
Load buttons. 

After sharpening and major corrections, you may 

wish to either merge some layers or downsample to 
8 bits per channel to avoid working with huge files. 
The question of when to merge or downsample is 
largely a matter of personal preference and the 
capability of your hardware. It’s generally true that 
you’ll get better results working in high-bit mode 
than in 8-bit mode, but after the big initial edits the 
advantages get smaller. We all have different pain 
points, so we recommend staying in high-bit mode 
until it starts to hurt.

Once you have added the various Effects to the Batch list, 
you can save the Batch list for future use. Click on the Save 
button and you will be presented with the Save Batch Set 
dialog.

The Save Batch Set dialog allows you to name the Batch 
list for future use. Note: if you don’t save the Batch list, 
the next time you launch PhotoKit SHARPENER 2, the 
effects will no longer be in the list. You must actually 
save the list to be able to access the saved Batch list.
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   We at PixelGenius know that many of our users 
are using either Camera Raw (ACR) or Lightroom 
or both,  and we wanted to give PKS 2 users the 
optimal workflow to combine the best parts of all 
the potential applications. That said, it’s really an 
either/or proposition. Either you use the capture 
sharpening in ACR or Lightroom and not in PKS 
2 or you use the capture sharpening in PKS 2, not 
in ACR or Lightroom. You really can’t use both 
successfully. However, there is a way of using all the 
products successfully and that’s what this section is 
all about.

Regardless of whether you use ACR/Lightroom or 
PKS 2, the odds are real good that you’ll be going 
through Photoshop at some point. Even though 

Lightroom (and to a certain extent ACR) has 
minimized the necessity of running all you images 
through Photoshop, there is still a present need to 
process at least your best images in Photoshop. 
So here are the steps for creating a raw processing 
workflow which includes PKS 2.

There are really two basic options; either use ACR/
Lightroom for capture sharpening or use PKS 2. 
In either case we strongly recommend doing the 
vast majority of your image adjustments at the raw 
processing stage. You always want to do major tone 
& color correction before sharpening and you’ll want 
to do most if not all of your noise reduction as well. 
You should also take advantage of ACR/Lightroom’s 
lens corrections prior to capture sharpening. 

Using PhotoKit SHARPENER 2 with Camera Raw or Lightroom and Photoshop

Using PKS 2 & Camera Raw. After adjusting the 
tone and color correction, the first step is to turn 
the Amount of the sharpening in the ACR Detail 
panel to zero. Regardless of the other sharpening 
controls, it is the Amount setting that applies the 
actual sharpening. In the figures above, we’ve set the 
Amount to zero. You will note that we have applied 
a small amount of Noise Reduction (even though 
this is a well exposed, low ISO image). We’ve found 

that nearly all images can benefit from at least a tiny 
amount of noise reduction and we feel that ACR/
Lightroom’s noise reduction is very good. You’ll also 
see that we’ve enabled the Lens Profile Correction 
for the lens we used to shoot the original capture.

Once these settings have been applied, the next step 
is to open the image into Photoshop for additional 
processing using PKS 2 prior to printing. Our next 
step will be to apply some capture sharpening.

The Camera Raw main dialog.
The Camera Raw Detail panel 

showing the Amount set to zero.
The Camera Raw Lens Correc-
tion panel with the Enable Lens 
Correction option checked with 

the correct lens selected.
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Capture Sharpening. Since we turned off capture 
sharpening inside of Camera Raw, the first step is to 
apply the PKS 2 Capture Sharpening. We’ve selected 
the Digital High-Res Sharp Set and the Auto Edge 

Sharpen effect. The resulting layers and group are 
shown above right. If needed, we could modify 
either the layer masks or the overall layer opacity. 
The next step is to add some creative sharpening.

Selecting the PKS 2 Capture Sharpening. The layers, masks and layer groups
created by PKS 2.

Selecting Midtone Contrast-Middle from Special Effects.

The Midtone Contrast-Middle layer
with layer mask painted.

Creative Sharpening. While we are a fan of 
Camera Raw’s Clarity tool, we using prefer using 
the PKS 2’s version–the Midtone Contrast effects. In 

the figure above we’ve selected the Middle version. 
The figure above right shows the final layer mask. 
The final step will be to do output sharpening.

Selecting Inkjet Output Sharpeners Set and Glossy in the
Effect menu. We’ve also set the Width to 16 inches.

The final layer stack.        
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Output Sharpening. The final step in the 
sharpening workflow is to apply output sharpening. 
The figures on the bottom of page 34 show selecting 
the Inkjet Output Sharpeners Set and the and the 
Glossy Effect (lower left). You’ll also note that we 
used PKS 2 to change the final print dimensions so 
the Width would be an exact 16 inches. The final 

layer stack is shown on the lower right figure on 
page 34. Although we haven’t mentioned using 
Photoshop’s soft proofing capability found under the 
View menu, Proof Setup we highly suggest using  it 
prior to actually making a print from Photoshop (or 
even Lightroom if you are round tripping through 
Photoshop). 

Using PKS 2 & Lightroom. The steps for using 
Lightroom and PKS 2 inside of Photoshop for 
capture, creative and output sharpening would 
be the same once you opened the image into 
Photoshop. You would start in Lightroom in the 
Develop module and turn the Amount slider in the  

Detail panel to zero. The figures below show the 
same image inside of Lightroom’s Develop module. 
The lower right figure shows a close-up of the Detail 
panel. We used the same settings are we did for 
Camera Raw; zero in the Amount slider and 10 in 
the Noise Reduction.

Printing the final image in Photoshop CS5’s Print window.

The image in the Lightroom Develop module.

Close-up of the Detail panel.        
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From Lightroom to Photoshop to Lightroom 
for Printing. Once you’ve done the tone and color 
corrections in Lightroom (and set the sharpening 
Amount to zero) the next step is to open the image 
from Lightroom into Photoshop as shown in the 
figure above left. In the Photo menu in Lightroom, 
select Edit in Photoshop. Depending on your 
version of Lightroom and Photoshop (and ACR), 
you may get a message about having Lightroom 
render the image. This is expected if the Lightroom 
and Camera Raw versions are mismatched. In 

our case, Lightroom 3.3 and Camera Raw 6.3 (in 
Photoshop CS5) are matched. The steps required 
are the exact same steps shown previously on page 
34. However, to use Lightroom to print, you’ll need 
to save the image first so the processed tiff file is 
added back into the Lightroom catalog (above 
right). After saving the image, you can print from 
Lightroom. The key is to make sure you turn off 
output sharpening in Lightroom as shown on the 
lower right figure. Otherwise, you’ll double sharpen 
for output (which is a bad thing).

The image in the Lightroom Print module after saving. After output sharpening in PKS 2 you 
must be sure to uncheck the Print 

Sharpening checkbox.

Opening the image from Lightroom to Photoshop.

Saving the image from Photoshop adds the image
back into the Lightroom catalog.
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Lightroom Capture Sharpening & PKS 2.
What do you do if you do want to use Lightroom’s 

capture sharpening functionality but still use PKS  
2 for creative sharpening followed by Lightroom’s 
output sharpening for printing? You adjust the 
image in the Detail panel of Lightroom’s Develop 
module to get the best visual appearance at 1:1 (100% 
zoom) and then open the image from Lightroom to 
Photoshop to add PKS 2 creative sharpening.

For this image, the prime difference is having 
to figure out the optimal capture sharpening in 

Lightroom manually. As shown below right, we 
adjusted the image to get an optimal sharpening 
setting. The Amount is 40, the Radius is .6, the 
Detail is 60 and the Masking is set to 10. How do 
you determine the settings? Setting visually is the 
only option.

In PKS 2, the only sharpening effect we used was 
the single Midtone Contrast-Middle as shown in 
the center figures on page 34. Since we’ll be doing 
output sharpening in Lightroom we bypassed the 
output sharpening in PKS 2 as well.

The image in the Lightroom Develop module.

Close-up of the Detail panel.        

Printing from Lightroom. The big difference in 
this situation is rather than doing output sharpening 
in PKS 2 you’ll make use of Lightroom excellent 
output sharpening. Why do we say Lightroom’s 
output sharpening is excellent? Because PixelGenius 
worked with Adobe and the Lightroom team to 
bring PhotoKit Sharpener’s output sharpening 
routines to Lightroom. From our point of view, 
you’ll get optimal output sharpening whether you 
do it in PKS 2 or Lightroom–it’s kind of like having 
the best of both worlds. To print from Lightroom 

you’ll need to check the option for Print Sharpening. 
As shown below, you’ll need to set the amount: 
Low, Standard  or High. Then set the Media Type 
to either Matte or Glossy. The same rules for PKS 
2 output sharpening apply to the media settings. 
In general, if you’ve done a good job of capture 
sharpening in Lightroom then we suggest Standard 
but test all three amounts on your own images. You 
could also choose to do output sharpening in PKS 
2 but you would need to turn off output sharpening 
in Lightroom as shown on page 36.

Setting the Print Sharpening 
amount to Standard.    

Setting the Media Type to Glossy.    
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Additional Info and Resources:
In addition to this manual, be sure to check out the

PKS 2 product page for additional information:
www.pixelgenius.com/sharpener2

For product updates and downloads:
www.pixelgenius.com/downloads.html

For Tech Support please use the web form found at:
www.pixelgenius.com/support.html

For information about your order from
eSellerate, our on-line fulfillment provider, please visit:

www.store.esellerate.net/store/support
Credits for PKS 2:

Product Design: Martin Evening, Bruce Fraser, Mac Holbert,
Seth Resnick, Andrew Rodney, Jeff Schewe & Mike Skurski

Product Manager: Mac Holbert
Specification Manager: Jeff Schewe

Software Architecture: Mike Skurski
Software Engineering: Michael Keppel

PhotoKit SHARPENER 2 is a trademark of Pixel Genius LLC. ©2010-All rights reserved.
www.pixelgenius.com

About PhotoKit SHARPENER 2.
To see your serial number for PKS 2 or to 

deactivate your install of PKS 2, you can access the 
About PhotoKit SHARPENER 2 splash screen from 
within Photoshop.

On Mac you’ll find it under the Photoshop menu 
in the About Plug-in submenu. On Windows it’s 
under the Help menu About Plug-in submenu. The 
splash screen is shown below.

The PKS 2 splash screen
(Note: the actual serial number has been obscured).

Thanks to You from the PixelGenius Team.
We hope this manual is helpful to you. We want 

to thank our users for all their help and support 
over the years–the pleasure has truly been ours. We 
started PixelGenius with the goal of making useful 
products that we would like to use. We did and we 
do.

But, it is because of the strong support of our user 
base that we created PhotoKit SHARPENER 2 so 
to you, we say thanks. We would also like to thank 
and remember two former members of PixelGenius 

who sadly are no longer with us. Mike Skurski was 
the engineer that originally got this merry band 
of brothers together. His insight and dedication 
allowed us to create simple tools that we wanted 
to use. We also wish thank and remember Bruce 
Fraser who was the original inspiration, designer 
and product manager for PhotoKit SHARPENER. 
We miss both–as does the entire industry. We also 
want to thank both John and Thomas Knoll for 
creating Photoshop in the first place (otherwise we 
couldn’t develop plug-ins). Thanks guys!.


